
Open Manage Printer Manager – Release Notes 

Package Release Numbering: 1.2
The following is the format for release/version numbers: 

<ProductID>.<Major Version>.<Minor Release>.<Maintenance 
Release>.<Build #>

When contacting Customer Support, please refer to the complete release number 
for components , which is in the Help > About Box. The versions mentioned 
below refer to component versions rather than the package.

Significant New Features in This Release
New or recent features in OMPM include the following:

• The following are newly supported models.

Dell 3130cn

Dell 2130cn

Dell 2135cn

Dell 2335dn

Dell 5330dn

• The following non-Dell printers are also supported in this version: HP1505, 
HP2015, HP3035, HP3505, Lexmark642, Lexmark644, Lexmark646, 
Lexmark770, Xerox8550, Samsung650. 

• You can now filter displays to show groups.

• This OMPM version is upgradable from OMPM v1.1

• Email setup is improved (you can now send e-mail notices without editing a 
text file with your e-mail information).

• You can now use wildcards in the Discovery IP ranges.

• Usage trend reports have been enhanced.

Platform
For a complete look at the new  functionality, consult the User Guides. Highlights 
of the new functionality in this release include the following:

• Topology improvements —Improved labeling with zoom, Improved con-
trols, Display customization and dockable screens, Export Views

• Microsoft Vista® and Server 2008 support

• Graphical report enhancements.

• Improved Managers 

• A UseridConstraint category is now in the application security policy. It has 
one property: Minimum Userid Length. The default value is 0. (31453)

• E-mail notifications from events can now include subjects with variables 
(SourceIP, Name, and so on). Consult the User Guide for specifics. (24746)
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• This version supports migration from previous versions. Consult the Installa-
tion Guide for details.

Known Issues
General

• Virus Warnings—Two files installed with this product—bash.exe or 
md5sum.exe—may trigger warnings with some anti-virus software. If you get 
a virus detection warning for these files during installation, take no action.

• Custom Debug—For more advanced users, any component under owareapps 
can define a log4j.xml file for each component matching the following pat-
tern:

owareapps\<component-dir>\server\conf\*log4j.xml 

Consult these files for categories you want to change, and copy those 
(altered) properties to the file you created in owareapps\installprops. The cat-
egories altered in this file override any others. 

• Limitation of Context-Sensitive Help—When you call a help screen, con-
text-sensitive help typically appears for the entire screen, not vendor panels—
although some exceptions to this rule do exist. Workaround: Search the 
index for the context-appropriate helpscreen. (44149 / 214)

• In some managers, the max row count limits any query to return the proper 
number of items, but changing it may return an inaccurate number of rows. 
(44454)

• “Too many open file” errors appear in logs. Workaround: On Redhat Linux 
installations, modify /etc/security/limits.conf on the application 
server/mediation server installations. Add the following to the file to lift the 
file limits:

username hard nofile 90000

username soft nofile 90000

Replace username with the name of the user under which the application 
server was installed. (44236)

• Uninstalling on Windows XP, Service Pack 3 may produce a benign error: 
“owprocmon.exe has encountered a problem and needs to close.” (43481)

• You can delete a filter already in use for a manager. If you do this, then the 
next time you open that manager, it opens with its default filter. (43008)

• To see all available content, you may have to resize subpanels when looking 
at Audit Trails in a web client. (41045)

• In some screens of the web client, you may have to resize the screen to see all 
fields and labels. (42420)

• A “cannot open Internet site...” error appears while opening Web client. 
Workaround: Such an error appears when you take the focus off the browser 
while the browser displays the opened manager page. To avoid the error, do 
not move focus. Alternatively, you can update your browser to Internet 
Explorer is version 7.0.5730.13 or later. (42279)

• An error message about changing colors may appear when you install on a 
machine with Windows Vista AERO Graphics (3D graphics) enabled. This 
occurs because the operating system is scaling back to 2D graphics for the 
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installer. You may also have to resize some installer screens to read the text. 
This is a benign error that does not otherwise affect the application’s perfor-
mance once it is installed. (42050)

• In the web client, some forms display a warning to the user about slow 
scripts. Click Continue and the script will complete. 

Work arounds to extend the script time-outs for the supported browsers:

For Internet Explorer, see http://support.microsoft.com/kb/175500 setting 
the decimal value to, for instance, 10000000.

For Firefox, set the URL to about:config, and set 
dom.max_script_run_time to a larger number, like 20. (42096)

• When you shut down the application server using Server Manager, the fol-
lowing error may appear: Could Not Stop the Oware Service Manager on Local 
Computer. The application server will stop in 30-60 seconds. You must wait 
until the Service Manager Stop Service progress bar completes before attempt-
ing to restart the application. Even when the error appears, the application 
server still shuts down. (41862)

• When you delete a device already scheduled for device discovery resync, an 
Equipment Not Managed entry replaces it in the scheduler screen. (42133)

• When you manage a device by hostname, even though this application can 
collect and manage other information from the device, the listed manage-
ment interface IP address does not update on resync if DHCP or some other 
process changes the IP addresses for the device. (42328)

• If you want to use the web client with a Linux server, you must use the pro-
cess monitor to start the application server, or otherwise ensure Xvfb is run-
ning prior to starting the appserver. For example, here are commands to start 
Xvfb (run as root):

Linux:

/usr/bin/Xvfb :0 -dev vfb screen 0 1152x900x8 & 

or

/usr/X11R6/bin/Xvfb :0 -screen 0 1152x900x8 &

(42469)

• To set the environment correctly for command line functions, after installa-
tion, type oware (or . /etc/.dsienv in Linux—[dot][space]/etc/[dot]dsienv) 
before running the specified command. Also: This application can run on any 
Linux desktop environment (CDE, KDE, Gnome, and so on) but the installer 
will only install shortcuts for CDE. (36442)

• For Linux, you must install no more than a single instance of MySQL—the 
one installed with this Element Management System. Before you install, 
remove any MySQL if it exists on your Linux machine. 

Alarms and Events
• Events with no corresponding definition appear as alarms of indeterminate 

severity.  The only way to change behavior of an unkown event in this ver-
sion would be to locate the missing MIB and load it into the system. This cre-
ates the missing event definition(s) needed to specify explicit behaviors.

http://support.microsoft.com/kb/175500
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• Northbound action can now send as proxy.  With this option set, there are no 
issues with XP’s security patch.  The application attempts to spoof sourceIP 
on packet only when the proxy option is not selected.

• This application’s server on Windows 2000 may not recover well if it loses 
network connectivity. Network connectivity is required to use the applica-
tion. This only occurs with "Link Downs" (unplugging the server cable, shut-
ting down the switch its plugged into, etc). Loss of network connectivity via 
the IP network (Layer 3) will not cause any problems. Workaround: You must 
restart system if this problem occurs. (13870)

• Trap listener, Inform listener and all outbound SNMP requests must bind to a 
specific interface in a multi-homed environment.  This interface is considered 
appropriate to use for all network-facing SNMP activity.  By default, this is 
localhost, interpreted as the application's local IP value (the NIC selected at 
installation time).  The following text in installed.properties provides a spe-
cific IP address to control outbound SNMP interface binding on the local 
machine (22258):

#

# specific interface used for all NMS initated

# communications to the network

com.dorado.mediation.outbound.address=localhost

Include the following text and provide a specific IP address to control 
inbound (listener) interface binding on the local machine:

#

# specific interface used for binding mediation

# listeners such as SNMP trap listener

com.dorado.mediation.listener.address=localhost

• Logical Topology: Contact filters do not retain their settings after operation. 
(14133)

Printer-Specific Issues

Unsupported Printers
The following Dell printer models and adaptor are not supported by this soft-
ware:

Dell AIO Ink printers

Dell Photo printers

Dell Laser Printer 1110 and others without the “n” suffix

Dell Wireless Printer Adapter 3300

• This software cannot write to Dell 5330 & Dell 2335 printers.

• Changing ethernet settings from 100 Base T Half to 100 Base T Full does not 
change the Current Speed field. It remains as 100 Base T Half Duplex. 
Workaround: Begin the change from some setting other than 100 Base T 
Half. (44344 / 226)
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• Both the Samsung 600 and 650 report the same data, and so are indistin-
guishable, when managed. (42606)

• Some Samsung and Dell printers report themselves as HP printers because 
they have the same vendor enterprise number in their object identifier. 
(42616)

• Lexmark 642, 644, 646 display an empty front panel status. This is a printer 
issue because the default SNMP printer MIB does not work for these models. 
(42525)

• This version updates the printer driver to work with the updated platform.

• For GDI printers (like the 1320 and 3010), printing a test page is not success-
ful even though application may indicate that it is. (37051)

• On the printer snapins PCL1 and PCL2, changing the Paper Size or Orientation 
settings produces Error storing attributes.. if value ranges determined by the 
measurement field are metric. Only imperial measure is currently supported. 
(37550)

Client UI
• If you scroll right one or more page widths in Printer Manager or Event His-

tory window, then click the upper right "+" to open the column list box, you 
can select a column and drag & drop to where you would like it onscreen.  
However, when this is performed, the horizontal scroll bar erroneously shifts 
to the far left position and the column selected appears in the first page width 
relative to the leftmost position instead of on one of the following pages 
where it was intended.  (31115 / 57)

• When choosing to filter By Status, occasionally the query stalls at 'Fetching 
Children (please wait)'. Workaround: Re-save that particular filter. If you hit 
the configure filter button (blue funnel) you will recieve an error message 
regarding a class cast exception (text is 'Error->java.lang.String"). Dismissing 
the error dialog will bring you to the filter configuration panel. Pressing the 
save button will re-save that filter. From that point further the error does not 
appear.  (31979)

• The 24-hour time field displayed in Printer Editor exists so users can set the 
time on the selected printer. The field only pushes 24-hour time to the 
printer, it does not display a time polled from the printer. (31321)

• The online help may refer to features not in the basic application. (32224)

• If you change the polling interval value in the printer.properties file, ensure 
that the minimum value is not less than 80 (seconds). (31898)

Web Client
• Web Client: The order in which you can tab between fields in some web cli-

ent screens may be unexpected (for example, in the Location editor). (31175)

• Web client: Editors opened in a maximized browser may not entirely fill the 
browser screen. (31182)

• Web Client: While using the web client, the browser buttons (back / next) may 
display an alternate manager after you perform a Save operation in an active 
manager screen.

• Web Client: Occasionally, some edit buttons may not work correctly on 
Mozilla Firefox browsers. Workaround: Press button in its non-text area.



Open Manage Printer Manager – Release Notes6
Printer Operations
• Printer names discovered are only host names.  Other names are the names 

that the printers use for EtherTalk. This application does not support Ether-
Talk settings, AppleTalk and LexLink (on LexMark printers). (30573)

• During printer discovery, some printers (e.g. Dell 5110cn), may display a 
minor warning when no value is found in the Email List fields:  

"EMail List 1: Failed to find match for exp.textarea<name="103030">-
>text.*(.*)"    

These warnings can be safely disregarded. (30947)

• Adding HTTP credentials to a printer that did not already have credentials 
associated with it produces an error (null pointer exception).

• If you enter multiple e-mail addresses in the Email alert lists (1 & 2), they 
must be separated by commas without space separation. Other separators, 
including spaces before or after the command, may result in the disappear-
ance of field values and other issues. (34416)

• No edit button exists for non-Dell Toner Details Panels. (30948)

• Fuser adjustment - this application incorrectly allows alphabetic characters. 
The use of an alphabetic character (instead of a numerical value), sets the 
Fuser adjustment to its "High" setting.

Installing Templates for New Printers

Templates translate messages from printers into Print Manager messages. To com-
pletely manage new types of printers, you must download new templates from 
the support page at www.dell.com, then register them.

To register at template, follow these steps:

1. Copy or move the printer templates into the template directory located at 
...\owareapps\printer\lib under your installation directory

2. Open a command shell. Start > Run cmd.

3. Type oware on the command line and press Enter.

4. Run the registertemplate command at the subsequent command line. 
Here is the syntax of that command:

registertemplate <template_file_name>

The template_file_name needs to be a complete path to the file. If you pro-
vide no filename then the script will re-register all template files in the 
owareapps\printer\lib directory. Best practice is to copy the template file 
to the owareapps\printer\lib directory and then run the 
registertemplate command. 

Once you have registered the new template(s), resync uses the new template(s). 
You must also stop and restart polling on the new printer models. This forces the 
application to rebuild the polling subscriptions with the new template informa-
tion.

Rediscovering the printer is unnecessary. Stopping then re-enabling polling 
builds the polling subscription with the new values from the template. If the tem-
plate addressed identification issues (serial number, MAC address or host name), 
page count, toner levels or toner max levels then you must stop the trend polling 
and restart that as well. 
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Issues Resolved
General

• If you are upgrading from a previous version, you must close all shells in 
which the oware script is running. (38571)

• In Linux, clicking Go makes columns in some managers squeeze to the left. 
Workaround: Use a Windows Client. (38314)

• You cannot give a user permission to configure authentication without giving 
him permission to access all managers. (SCR 24302) 

• The cursor position onscreen may temporarily conceal field contents in, for 
example, the Equipment Editor screen (24224)

Printer
• If you add multiple filter criteria in the printer manager panel (click on layout 

> Filter > Edit Filter and add the filter criteria, for example: Error alarm and 
ADF scan page count--then save) scrollbars may partially cover the new fil-
ters. (32202) 

• The value for the 9100 port is not writable on the HP 2840—a device visible 
thanks to generic discovery. The edit button is disabled so you cannot alter 
fields related to this port. (35936)

• Printer Discovery: On rare occasions, printer duplicates may appear if you ini-
tiate multiple discovery operations across the same address range either with 
multiple UI clients or overlapping scheduled discovery operations. 
Workaround: Best practice is to do only a single discovery operation at a time 
on a particular IP address range. If duplicates do appear, simply delete the 
duplicate printer entry. (31575)

• Client UI: Filters that have more than two criteria will not appear in Printer 
Manager with all criteria displayed. Also: A large blank appears above the 
listed printers if you remove all filter criteria. (32025)

• Web client: Clients may display superfluous scroll bars when you resize the 
browser. (31234)

• Client UI: When you are editing something like a filter, or inventory config, 
you cannot accept your changes unless you completely accept the criteria you 
are entering. The message that appears is something like this: "You are in the 
middle of a Criteria Edit. Please Apply Filter Changes (Green Checkmark 
Icon) or Undo Changes (Blue Undo Icon)." (31189)

• Client UI: Sometimes the Window menu list of screens displays phantom 
entries. Workaround: Selecting one of these entries makes the screen and 
Window list refresh, removing the phantom entries. (30988 and 31012)

• Client UI: If you scroll right one or more page widths in Printer Manager or 
Event History window, then click the upper right "+" to open the column list 
box, you can select a column and drag & drop to where you would like it 
onscreen.  However, when this is performed, the horizontal scroll bar errone-
ously shifts to the far left position and the column selected appears in the 
first page width relative to the leftmost position instead of on one of the fol-
lowing pages where it was intended.  (31115)

• Web client: Clients may conceal portions of filters. Workaround: use the 
scrollbar to see all available filter criteria. (31456)
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Event / Alarm Management
• The default database aging policy (DAP) exists for Events in Event History, 

but is not scheduled, again by default. Events can come into the system at 
fairly high rates, and as a result can consume space in the database at similar 
rates. 

Review the default DAP and default schedule to ensure that it is aggressive 
enough for your deployed system. (38213)
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